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Accessible Documents and Emails  
 

Focus: 
This document provides information about dcument accessibility.  We want to assure 

all students can perceive, operate, and understand the electronic documents 

distributed online or on ground.  The items to assess in the checklist are guidelines 

taken from federal and international organizations. The idea is to make the web a 

place for every type of person. 

Checklist:  (WebAIM - goo.gl/tVt53v) 
• Heading Styles 

• Alternative text for images 

• Data Tables 

• Links 

• Lists 

•  Columns 
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Heading Styles 
A uniform heading structure is often the most important accessibility consideration in 

Word documents. When encountering a lengthy Word document, sighted users often 

scroll the page quickly and look for big, bold text (headings) to get an idea of its 

structure and content. Screen reader and other assistive technology users also have 

the ability to navigate Word documents by heading structure, assuming Word's 

Heading styles are used. 

Structure Through Hierarchy 
Pages should be structured in a hierarchical manner: 

• A Heading 1 is usually a page title or a main content heading. It is the most 

important heading, and there is generally just one. 

• A Heading 2 is usually a major section heading. 

• A Heading 3 is usually a sub-section of the Heading 2. 

• A Heading 4 is usually a sub-section of the Heading 3, and so on, ending with 

Heading 6. 

Technically, lower-degree headings should be contained within headings of the next 

highest degree. One should not skip heading levels, such as using a Heading 4 directly 

below a Heading 2. 
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Example of Heading Style Hierarchy 
The following outline shows an example of hierarchy. 

Heading 1 

 Heading 2 

 Heading 2 

  Heading 3 

  Heading 3 

  Heading 3 
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Navigating the Structure 
Word documents with a proper heading structure provide the viewer with a navigation 

pane to jump through the document with.  The heading structure also assists blind 

readers to navigate the document.   

Sighted and blind students will be able to: 

• View a list of all of the headings on the page. 

• Choose top-level headings (Heading 1), next-level headings (Heading 2), third-

level headings (Heading 3), and so on. 

• Blind and sighted users can easily jump to different sections within the 

document.  Multiple people benefit from heading structure. 

Styles to Avoid  
A common practice is to use Bold or Underlined text to emphasize or appear as a 

heading. 

Examples: 

Required Course Text 

Accounting 15th Edition… 

Unfortunately, it is a common practice to create a "heading" by changing the text 

directly in a Word document. A user will highlight the text and apply a different font 

type, a larger font size, bold formatting, etc. While these changes made with Font 

styling will provide visual structure for some of your users, the document structure 

needed for navigation by assistive technology users is missing. For this reason, use the 

Heading tool provided by Word. 
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Apply Heading Styles in Microsoft Word  
Put the typing cursor in the line of text to be made a Heading Level > go to the 

“Home” tab of the ribbon > then click the desired heading level.   

If you choose a heading style and it changes your formatting, don’t worry.  Right click 

on the heading style and choose “Modify” 

Choosing “Modify” will allow you to change the format for the selected heading style.  

Going forward, the modified heading style will continue throughout the document. All 

of the heading styles can be modified to suit your formatting.  If you mark many lines 
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of text with a heading style #, the “modify…” option is great to change all the 

heading style #s at once.  

You may already have text in 

your document that is ready to 

be marked a heading style.  You 

may not want the font or color 

to change to the default setting, 

so you could select the “Update 

Heading # to Match” when right 

clicking on a heading style.  

Choosing this option will keep 

the text exactly as it originally was while the text is tagged as a heading level. 
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Navigation Pane 
To check if the document is being structured properly, go to the “View” tab in the 

ribbon > check the box for the navigation pane 
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Alternative Text for Images 
Alternative text is needed in Word documents to provide a non-visual means of 

representing the CONTENT or FUNCTION of an image. There is more than one way to 

provide "alt text", but all images contained in a Word document must have it. 

Image types in Word 
The following items can have alt text associated. 

• pictures 

• Illustrations 

• Images of text 

• Shapes 

• Charts 

• SmartArt 

• Tables 

When alt text is added correctly to an image, screen reading software can "read" it in 

a Word, PDF or HTML file. 

Best practices for alternative text 
Alternative text should be: 

• Accurate and equivalent—present the same content or function as the image. 

• Sufficient —no more than a few words are necessary; rarely a short sentence or 
two may be appropriate. 

• NOT be redundant—do not provide information that is in the surrounding text. 
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• NOT use descriptive phrases—screen reading software identifies images, so do 
not use phrases such as "image of..." or "graphic of...". 

Applying Image “Alt Text”  
1. Insert the photo 

2. Right click the photo 

3. Click “Format (Picture, etc.)” 

4. Click the 3rd icon to add the “alt 
text”  
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Data Tables 
The purpose of data tables is to present information in a grid, or matrix, and to have 

columns or rows that show the meaning of the information in the grid. Sighted users 

scan a table to make associations between data in the table and their appropriate row 

and/or column headers. Screen reader users make these same associations with tables 

in web pages and PDF files. 

Table Properties 
You can add properties to a table in a Word document. This will provide a screen 

reader user with additional information and navigation when the document is 

exported to PDF or HTML/Web Page. 

2 properties to add to a table: 
1. Repeat header rows.  If the table starts with a row that should repeat for each 

corresponding row.  

 Example of header row: “Week, Reading, Assignment” 

Week Reading Assignment 

August 21 and 24 Chapter 5 and 6 First Draft is due 

 

The “Week, Reading and Assignment” columns will repeat and associate with the rows 

below.  This type of table will need a “Repeat Header Rows” property added. 

2. Alt Text will also be added to the table.  It is important to label the tables with 

alternative text just like images and shapes.  This will indicate to users which 

table they are on and how to differentiate one table from another. 
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Applying Table Properties 
1. Select a table.  Click on the “+” symbol at the upper left of the table.  Clicking there will 

highlight the entire table. 

 
2. Right click on the highlighted table. Choose “Table Properties…” 
3. Click on the “Row” tab 
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4. Next, choose the “Alt Text” tab 
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Links 
Links in electronic documents are best presented as hyperlinks.  A hyperlink is a 

website address (URL) or an email address and it is hidden behind the body text. 

Hyperlinks are visually pleasing to all individuals. 

If you are printing a document, it is best to display the website as a shortened URL, 

the shortened web address with make it easy to re-type.  Google has a great tool for 

making URLs very short.  https://goo.gl  

Follow these principles when making hyperlinks: 

• Use descriptive link text that does not rely on context from the surrounding 
text. 

• Keep the amount of text in the link to a minimum. 

• Use underlined text with a color that stands out from the surrounding text. 

Applying Hyperlinks: 
A hyperlink can be created by: 

1. Highlight desired text 

2. Right click on highlighted text 

3. Choose “Hyperlink…” 

4. Paste the URL in the “Address:” 
field. 

Keyboard shortcut: 

1. Highlight the desired text to be a 
hyperlink 

2. Press “ctrl + k” to make the text 
a hyperlink. 
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Lists & Columns 
Lists and columns add important hierarchical structure to a document. Sometimes 

users create "lists" and "columns" manually by hitting the Tab to indent content. While 

this provides visual structure for sighted users, it does not provide the document 

structure needed for assistive technology users. 

Use ordered or unordered lists.  Ordered lists are sequential with number values and 

unordered lists should be presented as bullets. 

Ordered List: 

1. Do this 

2. Then that 

3. Now this 

Unordered List 

• Scissors 

• Ruler 

• Pencil 

Applying Lists 
1. Highlight the desired text to become a list 

2. Go to the “Home” tab of the ribbon 

3. Click the button with the numbered list or bulleted list 
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Applying Columns: 
Design the document with columns instead of spaces and tabs.  Columns will present 
the document evenly. 
1. Highlight the desired text to be separated into columns 
2. Click on the “Layout” tab in the ribbon 
3. Click “Columns” 
4. Choose desired number of columns 

Ordered List: 

4. Do this 

5. Then that 

6. Now this 

 

Unordered List 

• Scissors 

• Ruler 

• Pencil 
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Converting Documents   
Web Page (.html) 

1. Go to “File” 
2. Save as… 
3. At the bottom of the save window, choose the format “Web Page (.htm)” 

(A file and a folder will be created in the saved location) 
 
PDF Portable Document Format (.pdf) 

1. Go to “File” 
2. Save as… 
3. At the bottom of the save window, choose the format “PDF (.pdf)” 

 

The saved documents are now utilizing accessibility features.  The HTML file is most 

accessible for blind individuals because it provided linear navigation.  The HTML file is 

set as a single page and the user does not have to navigate to separate pages.  The 

PDF file also contains the accessibility features, but it is divided into separate pages 

and the user will have to navigate to the page chooser to move forward.  Both types 

of documents are set and do not allow the user to edit the content, so html is 

essentially a PDF without pretty formatting. 

Note about Canvas: 
In Canvas, you can upload a PDF, DOCX, etc, but it would be most beneficial if the 

built in tools were used inside Canvas.  It is possible to use all of the elements above 

in the Canvas software (headings, alt text, tables, links, lists and columns). When the 

built-in tools are used, the content will be displayed elegantly on any screen size.  If 

a PDF is used, the document will not display properly on small screens.    

There is even an “Accessibility Checker” in the content editor of Canvas. 

 
For more information on utilizing the built-in tools with Canvas, contact Tracie Bosket 
tbosket@vcccd.edu 
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Microsoft Outlook 
With Outlook, you can easily send accessible emails.  All of the elements used above 

will also apply to Microsoft Outlook.  Outlook will maintain the formatting for heading 

styles, alternative text for images or shapes, data tables, hyperlinks and lists. 

Sending an Accessible Email: 
1. Create a Microsoft Word document and use the heading styles, alternative text, data tables 

properties, hyperlinks and lists. 
2. Save the document  
3. Copy all of the content in the document (Select all text > right click > click “copy”) 
4. Go to https://owa.vcccd.edu > login (or your desktop email client) 
5. Compose new email 
6. Paste the content into the “email body” (Notice the images may have to be attached 

manually.) 
7. If attaching images manually, be sure to add alt text.  (right click on image > alt text) 
8. Send email 
 
Accessible emails can also be created within Outlook.  On the Desktop version of outlook, there 
is a Ribbon, similar to Microsoft Word. There you will be able to apply Heading Styles to text, 
Alt Text to images and tables, make Hyperlinks.   
 
The website version of Outlook, https://owa.vcccd.edu, has some accessibility features, but is 
limited to Alt text for images. However, as noted above, content from Microsoft Word can be 
copied and pasted into an email body with all of the formatting carrying over.  
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Legal 
 
The United States Access Board provides information on the current laws regarding education 

and technology accessibility.  

 

Section 508 Standards 
(Access-Board - goo.gl/Smga8y) 

 
 

Web Content Accessibility Guidelines 2.0 WCAG 

(World Wide Web Consortium - goo.gl/YQNa7o)  
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Section 508 
 
The Section 508 standards have been refreshed as of January 18, 2017.  The full text can be 
found at the AccessBoard website, https://goo.gl/PyzuPN. 
 
The most relevant update, in relation to document accessibility, is:  
 
“E205.4 Accessibility Standard. Electronic content shall conform to Level A and Level 
AA Success Criteria and Conformance Requirements in WCAG 2.0. For non-Web 
documents, wherever the term “Web page” or “page” appears in WCAG 2.0 Level A 
and AA Success Criteria and Conformance Requirements, the term “document” shall 
be substituted for the terms “Web page” and “page”.” 
 
The Section 508 Standards and the WCAG 2.0 work in collaboration to meet the eye of 
the law and to support access for all individuals. 
 

Music Video About WCAG 2.0  

 
https://goo.gl/K7PWnv (Closed Captioned) 
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Web Content Accessibility Guidelines 2.0 (WCAG) 
 
The W3C, World Wide Web Consortium, is where information can be found regarding internet 
standards.  The W3C’s mission is to lead the World Wide Web to its full potential by developing 
protocols and guidelines that ensure the long-term growth of the Web 
 
The social value of the Web is that it enables human communication, commerce, and 
opportunities to share knowledge. One of W3C's primary goals is to make these benefits 
available to all people, whatever their hardware, software, network infrastructure, native 
language, culture, geographical location, or physical or mental ability. 
 
WCAG 2.0 How to Meet the standards -  https://goo.gl/61pEX0 

 

WCAG 2.0 Conformance Requirement 1 - 4 Principles  - goo.gl/p645Cr 

Principle 1 - Perceivable  
Information and user interface components must be presentable to users in ways they can 
perceive 
 
Guideline 1.1 – Text Alternatives  
Provide text alternatives for any non-text content so that it can be changed into other forms 
people need, such as large print, braille, speech, symbols or simpler language. 
 
Guideline 1.2 – Time-based Media 
Provide alternatives for time-based media. 
 
Guideline 1.3 – Adaptable 
Create content that can be presented in different ways (for example simpler layout) without 
losing information or structure. 
 
Guideline 1.4 – Distinguishable 
Make it easier for users to see and hear content including separating foreground from 
background. 
Principle 2 - Operable  
User interface components and navigation must be operable  
 
Guideline 2.1 – Keyboard Accessible 
Make all functionality available from a keyboard. 
 
Guideline 2.2 – Enough Time 
Provide users enough time to read and use content. 
 
Guideline 2.3 – Seilzuges 
Do not design content in a way that is known to cause seizures. 
 
Guideline 2.4 – Navigabile 
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Provide ways to help users navigate, find content, and determine where they are. 
 

Principle 3 - Understandable 
Information and the operation of user interface must be understandable  
 
Guideline 3.1 – Readable 
Make text content readable and understandable. 
 
Guideline 3.2 – Predictable 
Make Web pages appear and operate in predictable ways. 
 
 
Guideline 3.3 – Input Assistance 
Help users avoid and correct mistakes. 
Principle 4 - Robust 
Content must be robust enough that it can be interpreted reliably by a wide variety of user 
agents, including assistive technologies. 
 
Guideline 4.1 – Compatible 
Maximize compatibility with current and future user agents, including assistive technologies. 
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Resources 
Microsoft Word and Outlook 
 

Accessible Document Checklist:  (Web AIM - goo.gl/tVt53v) 
 
Legal 
 
Section 508 Standards (Access-Board - goo.gl/Smga8y) 
 
World Wide Web Consortium - goo.gl/YQNa7o) 
 
WCAG 2.0 How to Meet the standards -  https://goo.gl/61pEX0 

 
WCAG 2.0 Music Video - https://goo.gl/K7PWnv 
 
 


